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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other 
printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials

Digital cameras and scanners, like photocopiers, conventional cameras, and ink jet printers, can be misused by 
improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras, 
scanners, and ink jet printers.

Trademarks
EPSON, EPSON Stylus, EPSON Photo Stickers, and MicroWeave are registered trademarks and PRINT Image 
Matching is a trademark of SEIKO EPSON CORPORATION.

EPSON Print Lab, EPSON PhotoCenter, EPSON Store, SoundAdvice, and EPSON Connection are service 
marks; and ColorLife, EPSON Software, BorderFree, and PhotoEnhance are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

 Printed on recycled paper 
Copyright © 2002 by Epson America, Inc. 7/02 CPD-14526
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Welcome!

Your EPSON Stylus® Photo 825 is the ideal printer for digital photography. You can 
print your pictures directly from your digital camera’s memory card without even 
turning on your computer.

Create true BorderFree™ photos directly from your printer—in a variety of sizes 
perfect for albums or framing. You get quick and easy snapshots and enlargements 
just minutes after taking pictures with your digital camera. 

If you want to edit your pictures, you can transfer them immediately to your 
Windows® or Macintosh® computer and print from there. 

Here are some of the printer’s outstanding features:

■ EPSON’s exclusive 6-color ink technology gives you beautiful digital photos that 
look like traditional photographs, as well as crisp everyday documents of all types. 

■ The built-in PC card slot works with most digital camera media, including 
CompactFlash™ Type I, SmartMedia,™ Memory Stick,® MultiMediaCard, and 
SecureDigital cards. (It also works with IBM® Microdrive™ and CompactFlash 
Type II adapters, which are sold separately.)

■ The roll paper holder included with your printer lets you produce continuous 
4-inch borderless snapshots—even without a computer.

■ An optional preview monitor is available to help you select photos and layouts 
before you print. (See page 99 for ordering information.)

■ Four-picoliter variable droplet ink technology achieves finer shadow detail, 
dazzling highlights, and better fill across a wider range of colors. 

■ Ground-breaking Resolution Performance Management™ (RPM) technology 
optimizes the number and placement of ink droplets on a variety of papers for 
superior photo quality and performance, with manageable print file sizes. 

■ Genuine EPSON ink and papers deliver long-lasting, water-resistant prints.
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2 Welcome!

PRINT Image Matching and Exif Print

Your EPSON Stylus Photo 825 printer supports these innovative digital image 
formats to give you the best photo prints possible:

■ PRINT Image Matching

■ Exif Print

About PRINT Image Matching

EPSON’s revolutionary PRINT Image Matching™ (P.I.M.) technology lets your 
digital camera and printer work together automatically to produce the best prints 
possible. Digital camera manufacturers that support PRINT Image Matching include 
EPSON, Casio,® JVC,® Konica,® Kyocera,® Minolta,® Olympus,® Panasonic,® Pentax,® 
Nikon,® Ricoh,® Sanyo,® Sony,® and Toshiba.® Check with your camera’s 
manufacturer to find out if PRINT Image Matching technology is included—or go to 
www.printimagematching.com to see if your camera supports it.

But don’t worry if your camera doesn’t include PRINT Image Matching 
technology—your EPSON Stylus Photo 825 gives great photo printing results, just 
without any possible adjustments P.I.M.-enabled cameras may add.

With PRINT Image Matching, the digital camera manufacturer can set specific 
printing options for each camera model. These options include:

■ contrast, sharpness, and brightness

■ gamma level, color space, and color saturation

■ shadow point, highlight point, and color balance

The camera saves this information in each image file. Your printer—along with 
EPSON Software™ Film Factory,™ the P.I.M. Plug-in for Adobe® Photoshop,® or 
ArcSoft™ PhotoImpression™—uses the information to ensure the most accurate 
image reproduction. 

���������	�
������������������������������������



Welcome! 3

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG files so your printer and application can use them to 
create accurate print settings. Most digital cameras store Exif Print information such 
as shutter speed; metering, flash, and exposure settings; resolution; and lens use in the 
JPEG image file. Your printer—along with EPSON Software Film Factory or ArcSoft 
PhotoImpression—uses the information to ensure the most accurate image 
reproduction.

About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. See the Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. 

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ Your photo software includes these great tools:

The EPSON PhotoStarter and CardMonitor utilities (installed automatically) 
help your system handle photos on a memory card. If you want, you can have 
your photos copied to your computer automatically—and even open one of your 
photo editing programs—whenever you insert a memory card from your camera.

EPSON Software Film Factory is a photo management program 
that lets you organize, beautify, and print your photos in a flash. 
Supports PRINT Image Matching and Exif Print. 

P.I.M. Plug-in for Adobe Photoshop lets you retain PRINT 
Image Matching image quality when you import JPEG files from your 
P.I.M.-enabled digital camera. (Compatible with Photoshop 6.0, 7.0, and 
Photoshop Elements 1.0.)

���������	�
������������������������������������



4 Welcome!

ArcSoft PhotoImpression is an easy-to-use photo editing 
program that lets you edit, enhance, retouch, or add special 
effects to any image with just a few clicks. Supports PRINT 
Image Matching and Exif Print.

■ Your on-screen Reference Guide gives you complete information about your 
printer. (You need a browser—such as Microsoft® Internet Explorer 4.0 or later, 
or Netscape® Navigator® 3.0 or later—to view the guide.)

■ EPSON PhotoCenter  is EPSON’s free photo-sharing web site 
where you can store, organize, and share your photos; print 
high-resolution photos straight from the web; and create free online 
postcards with your photos. Your printer software installer lets you 
add a link to the EPSON PhotoCenter on your desktop.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. For tips on 
printing without a computer, see the Quick Reference card. 

This book contains system requirements, important safety information, your 
warranty, and instructions on:

■ Printing all types of photos without a computer

■ Printing with Windows or on a Macintosh 

■ Maintaining the printer

■ Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, 
see your on-screen Reference Guide, as described on page 5. 

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

SM
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Viewing Your On-Screen Printer Manual

Your printer CD-ROM includes an on-screen Reference Guide (Printer Manual). You 
need a browser—such as Microsoft Internet Explorer 4.0 or later or Netscape 
Navigator 3.0 or later—to view it. If you are using a different browser, the pages may 
not display correctly. (A browser is not included on the printer software CD-ROM.) 

Follow the instructions on your Start Here sheet to install the manual with your 
printer software, if you haven’t already. You can view the manual at any time by 
double-clicking the Printer Manual icon on your desktop. 

When you first open the manual, you see this screen:

Click a topic on the left to expand the table of contents. After expanding the table of 
contents, you can click on the topic you want to view.

Click here to 
expand the 
table of 
contents
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6 Welcome!

■ If there’s a right arrow , click it to view subtopics, then click on a topic to go to 
it.

■ Click the down arrow to close a subtopic list.

If you see an icon for a graphic when viewing your manual in Netscape Navigator, 
click the Reload button to load the graphic.

Closed 
list, click 
to expand

Click to go 
to topic
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Printing Without a Computer

Your EPSON Stylus Photo 825 lets you print your photos quickly and easily without a 
computer. Just insert your digital camera’s memory card in the printer (with the appropriate 
adapter), choose settings from the control panel, and press the Print button. 

If your digital camera supports PRINT Image Matching, you can use this technology whenever 
you print without a computer. When you take pictures, simply point and shoot in automatic 
mode or select an image type like portrait, landscape, macro, scenery, or sport. 

With PRINT Image Matching, special print commands are saved in your photo files. For 
example, macro mode pictures might include commands for sharpness and clarity, while 
portrait mode pictures might emphasize soft focusing and subtle flesh tones.

When you insert your camera’s memory card in the printer, all the PRINT Image Matching 
commands are read and applied. If you don’t want to use the PRINT Image Matching 
information, just use the printer’s control panel to turn off PhotoEnhance,™ as described on 
page 17.

Before you start, make sure you plug in the printer, turn it on, and install ink cartridges, as 
described on your Start Here sheet. Then follow the instructions in these sections:

■ “Getting Photos into the Printer” on page 8

■ “Using EPSON Paper” on page 12

■ “Using the Control Panel” on page 14

■ “Printing Your Photos” on page 19

■ “Printing Snapshots on Roll Paper” on page 25

■ “Enhancing Photos and Using Filters” on page 29

■ “Printing Stickers” on page 32

■ “Printing Special Layouts” on page 34
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8 Printing Without a Computer

Getting Photos into the Printer

Before you can print, you need to take the memory card out of your digital camera, 
insert it into the adapter, and then insert the adapter into the printer. 

Your EPSON Stylus Photo 825 is designed to print digital camera files that meet 
these requirements:

■ JPEG files captured with a digital camera. The files must meet the DCF (Design 
rule for Camera File systems) Version 1.0 standard.

■ Resolutions ranging from 160 × 160 to 3200 × 3200 pixels

■ Up to 999 files on a memory card

Inserting Memory Cards

Digital cameras store pictures either in the camera’s internal memory or on a memory 
card. Your printer works with several different types of memory cards, as shown 
below. 

All memory cards (except PCMCIA Type II cards) require an adapter to work in the 
printer. A PCMCIA adapter (PC card adapter) for CompactFlash Type I memory 
card and a multimedia PCMCIA adapter are included with the printer. If your camera 
uses a different type of card, you can purchase the appropriate adapter. 

PC card (PCMCIA Type II)

CompactFlash Type 1

SmartMedia Memory Stick

Microdrive
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Printing Without a Computer 9

Make sure the printer is turned on, then follow these steps to insert your memory card 
for printing: 

1. Insert your memory card into the PC card adapter.

2. Insert the adapter into the printer’s card 
slot.

Make sure the card is straight and goes in 
as far as it can.

If your computer is connected to your 
printer and turned on, you will see a message on your 
screen the first time you insert a memory card (in 
Windows 98, Me, or 2000). Follow the instructions in 
the next section to respond to the message and 
configure PhotoStarter.

Make sure the arrow is up and 
pointing into the slot
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10 Printing Without a Computer

Configuring PhotoStarter

PhotoStarter and CardMonitor are utility programs that detect when a memory card 
is inserted in your printer and automatically copy photos to your computer (not 
available in Windows XP).

Note: If you’re using Windows XP, you don’t need PhotoStarter and 
CardMonitor. You can have Windows automatically copy photos to your 
computer when you insert a memory card. See your Windows Help for more 
information.

1. If you see the message shown on page 9, click Next. 

If you’re using a Macintosh, you have to open PhotoStarter first. Open the 
PhotoStarter folder on your hard drive, then double-click the  PhotoStarter 
icon.

The PhotoStarter setup assistant opens:

2. Click Next again. The setup assistant asks you a series of questions about how you 
want PhotoStarter to work.

If you don’t change the default settings, this is what will happen whenever you 
insert a memory card:

■ PhotoStarter will copy your pictures to the Photos folder on your desktop.

■ The pictures will be stored by date.

■ Film Factory will open automatically.
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Printing Without a Computer 11

3. Change any of the settings you want, then click Next. When you see the 
Confirmation window, click End (Windows) or Quit (Macintosh). 

You can go back and change settings at any time by opening PhotoStarter:

■ In Windows, click Start, point to Programs, Film Factory, and click 
EPSON PhotoStarter. Open the Settings menu and choose Change Settings.

■ On a Macintosh, open the PhotoStarter folder and double-click the 
PhotoStarter icon. Open the Tools menu and choose Change Settings.

Removing Memory Cards

When you’re finished printing from a memory card, make sure the processing light is 
not flashing before you remove the card.

On a Macintosh, select the memory card icon on your desktop and drag it to the 
Trash. If you remove the card without doing this, an error message will remain on 
your screen until you reinsert the card, and you may lose your images.

Caution: Do not eject a card while the processing light is flashing, or you may 
lose data on the card. 

In Windows 2000 or XP, click the  Eject Hardware icon on the taskbar and select 
Stop or Safely remove the Storage Device.

Press the button to eject the card. Then pull the card out of the slot.
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12 Printing Without a Computer

Using EPSON Paper

When you print without a computer, you can use letter-size plain paper, or the 
following types of EPSON special paper:

These papers are designed to give you professional-quality photos directly from your 
printer. Many more paper types and sizes are available when you print from your 
computer, as listed on the inside back cover.

With proper care, photographs from your EPSON Stylus Photo printer will last for 
many years. The special EPSON inks designed for your printer are formulated to 
achieve improved lightfastness when used with EPSON papers for prints that are 
properly displayed or stored.

Tip: For best results, always use EPSON papers.

Paper name Description Letter size 4 × 6 5 × 7 8 × 10 4” roll

Glossy Photo 
Paper

Perfect for 
snapshots, reprints, 
and enlargements

S041141
S041272
S041271

S041458 — — —

Premium 
Glossy Photo 
Paper

High Gloss photos 
for framing and 
albums

S041286 S041682 S041464 S041465 S041302

Matte Paper 
Heavyweight

Highest-quality 
matte photos

S041257 — — S041467 —

Premium 
Semigloss 
Photo Paper

Semigloss photos 
for framing and 
albums

S041331 — — — S041329

EPSON Photo 
Stickers®

Create fun stickers 
with or without 
colorful frames

— S041144
S041144KIT

— — —

Photo Quality 
Ink Jet Paper

Perfect for 
newsletters, 
scrapbooks, and 
flyers

S041062 — — — —

ColorLife™ 
Photo Paper

Fade-resistant 
photos with a 
smooth satin finish

S041500 — — — —
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Printing Without a Computer 13

As with traditional photos, proper care will minimize color changes and lengthen 
display life:

■ For display, EPSON recommends that prints be framed under glass or a 
protective plastic sleeve to protect them from atmospheric contaminants like 
humidity, cigarette smoke, and high levels of ozone. 

■ As with all photographs, keep your prints away from direct sunlight. 

■ For proper storage, EPSON recommends that you keep prints in a photo album 
or plastic photo storage box in acid free, archival sleeves commonly available from 
most camera stores.

Note: Always keep unused paper in the original package.

To order EPSON paper, contact your dealer or call the EPSON StoreSM at 
(800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

Loading Paper

Place your paper against the right edge of the feeder. Then slide the left edge guide 
against the paper.

Note: If any paper you buy comes with a cleaning sheet, don’t use the cleaning 
sheet with this printer; it may cause a paper jam.

■ Make sure the printable (whiter or glossier) side of the paper is face up.

■ Always load paper short edge first, even when you’re printing landscape-oriented 
pictures.
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14 Printing Without a Computer

■ Load up to 20 sheets of EPSON Photo Paper, Glossy Photo paper, or Matte 
Paper Heavyweight.

■ Load EPSON ColorLife, Premium Glossy and Semigloss Photo Paper one sheet 
at a time.

■ Load EPSON Photo Quality Ink Jet paper and plain paper up to the arrow mark 
inside the left edge guide.

Using the Control Panel

You can use the control panel to print everything from a quick snapshot to an 8 × 10 
enlargement. You can print a variety of layouts and even enhance your photos—all 
without turning on your computer.

You use the arrow buttons to select most settings for printing. The control panel 
displays the settings you choose for each of the 8 menus:

Use the arrow 
buttons to 
select menus 
and settings

Menus Settings

Press to start 
printing

Press if you need 
to cancel settings 
or cancel printing
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Printing Without a Computer 15

Use the  and  buttons to select menus:

Use the  and  buttons to select settings:

After you select all your settings, press the Print button to start printing.

Selecting Print Settings

Always check the settings before you start to print. 

Print Mode

The Print Mode determines which photos are printed.

Print a sheet with small, numbered copies of all photos. Unless you have the 
optional Preview Monitor, always start by printing an index of all the photos 
on the memory card.

Print all the photos on the memory card.

Print one selected photo.

Print a group of selected photos.

Paper Type

The printer adjusts the ink coverage for each type of paper. That’s why this setting is 
especially important.

Print on plain paper. Recommended for index or test prints.

Print on EPSON Premium Glossy, Premium Semigloss, or ColorLife Photo 
Paper. Use for enlargements, special layouts, or snapshots on roll paper.
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16 Printing Without a Computer

Print on EPSON Matte Paper Heavyweight. Use for non-glossy 
8 × 10 enlargements or special layouts. 

Note: You can also select Photo Paper and Photo Quality Ink Jet paper. See 
page 22 for instructions.

Paper Size

Make sure this setting matches the paper you loaded in the printer. 

Use for letter-size enlargements or printing multiple photos on one sheet. You 
can’t use this setting for borderless photos.

Use for snapshots on EPSON Photo Paper—with or without borders.

Use for enlargements on EPSON Premium Glossy Photo Paper.

Use for enlargements on EPSON Premium Glossy Photo Paper or EPSON 
Matte Paper Heavyweight.

Use for printing a series of borderless snapshots. You can print up to 52 
photos in one batch.

Note: You can print multiple photos on one sheet of any size paper.

Your images may not match the width/height proportions (aspect ratio) of the paper 
size and layout you’re using. Images may be cropped or trimmed around the edges to 
fit the paper and layout.

Page Layout

Print borderless photos—either on roll paper or one on each sheet of the selected 
paper. Photos will be slightly cropped around the edges and printing will be a bit 
slower (especially near the edges). 

Print photos with standard margins—one on each sheet of the selected paper.

Print two photos on each sheet of the selected paper.

Print four photos on each sheet of the selected paper.

Print three photos on each sheet of the selected paper.

Print one photo 20 times or 20 different photos on each sheet. If you print 20 
different photos, the photo number, date, and time are also printed. 
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Printing Without a Computer 17

Select Photo

■ When you’re printing one photo, press the  button to choose the number of the 
picture you want. Refer to your index print (or use the optional preview monitor) 
to identify the photo.

■ When you’re printing a Set of photos, press the  button to choose the number 
of the picture you want. For each picture you want to print, press the round 
Select Photo button. The number 1 appears on the Copies menu. (Press the 
Select Photo button again if you want to print more than one copy of a picture.) 

Note: If you change your mind after selecting a photo, press the Cancel button. 
(This cancels all your selections.)

Copies

■ Press the  button to set the number of copies you want to print. 

■ When you’re printing a layout with several photos on a page, use the Copies 
menu to set either the number of pages (in All, One, or Index mode) or the 
number of copies for each photo (in Set mode). 

Quality

Always use for the best photographic results.

Use for faster, draft printing and saving ink (not available for glossy paper).

PhotoEnhance

Use this setting if your camera supports PRINT Image Matching. If not, you 
can still use PhotoEnhance to print with optimized contrast, saturation, and 
color balance. 

Print without PRINT Image Matching and without enhancement.
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18 Printing Without a Computer

Changing the Default Settings

The printer comes with the following default settings for each print mode:

You can change the defaults to the settings you use most often.

1. Make the settings you want to use for one of the print modes.

2. Press the Select Photo and Brightness buttons at the same time. The settings 
are saved as defaults, even if you turn off the printer.

3. Repeat steps 1 and 2 for each print mode.

To change back to the factory defaults, first select the print mode you want to change, 
then press the Select Photo, Brightness, and Cancel buttons at the same time.

Note: If you want to select Photo Paper or Photo Quality Ink Jet paper, see 
page 22 for instructions.

Index

One

All

Set
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Printing Your Photos

Whenever you print, you need to insert your memory card and load paper, as 
described on pages 8 and 13. Make sure your printer is set up, plugged in, and turned 
on, as described on the Start Here sheet.

■ Unless you have the optional preview monitor, it’s a good idea to start by printing 
an index, so you can select your photos by number. 

■ If your camera supports DPOF (Digital Print Order Format), you can use your 
camera to select photos for printing. When you insert your memory card, DPOF 
displays on the Select Photo menu. Your photos are already selected.

You can press the  or  button on the Select Photo 
menu if you don’t want to use the DPOF settings.

Printing an Index

An index print shows small, numbered images of all the photos on your memory 
card—and includes the date each picture was taken. Make sure your card is inserted 
and plain paper is loaded in the printer. 

1. Check the control panel. It should display these 
settings (the defaults), including the number of 
photos stored on your memory card.

If necessary, press the Cancel button to restore the 
default settings.

2. Press the Print button. Your index is printed.

Printing Snapshots

First print an index to identify the photos on the memory 
card (as described above). Then choose the pictures you want to print. 

Follow these steps to print snapshots on 4 × 6 paper without cutting or trimming. If 
you want to print a series of snapshots on roll paper, see page 25.

Note: If you have EPSON 4 × 6 Photo Paper with perforations, make sure you 
tear off the margins before you use it to print without a computer.

Number of photos 
on the card
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20 Printing Without a Computer

1. Load up to 20 sheets of EPSON Borderless Photo Paper 4" × 6" in the printer, 
short edge first as shown. 

2. In the Print Mode menu, select Set. (If you want 
to print all the pictures on the card, select All.)

3. At the Paper Type menu, select Glossy.
 

4. In the Paper Size menu, select 4 x 6.

5. In the Page Layout menu, select  for borderless prints, or  for prints with 
white borders. 

(If you want to print all the pictures on the card or you’re using DPOF, skip to 
step 7.)

6. At the Select Photo menu, press the  button to display your picture numbers. 
For each picture you want to print, press the round Select Photo button. 

The number 1 appears on the Copies menu. (Press the Select Photo button 
again if you want to print more than one copy of a picture.) For pictures you 
don’t want to print, the number 0 appears on the Copies menu. 

Tip: Photo numbering may not match the numbering in your camera. Always 
refer to your index print to identify photos.

You can press the  or  button to scroll through your picture numbers and 
check that the correct setting appears on the Copies menu.

Slide the left edge 
guide against the paper

Make sure the printable (glossier) 
side of the paper is face up

Glossy
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7. In the PhotoEnhance menu, select On (if your camera supports PRINT Image 
Matching or to improve brightness and contrast) or Off. 

8. Press the large green Print button. The snapshots you selected are printed.

Note: If you’re printing more than 20 photos at a time, you’ll see PE flash on the 
control panel when your paper runs out. Load more paper, then press the b 
maintenance button to continue. 

Keep your pictures and unused paper away from high temperatures and humidity and 
out of direct sunlight. See page 12 for more information about storing and displaying 
your pictures.

Printing Enlargements

You can print 5 × 7, 8 × 10, or letter-size enlargements suitable for framing, without 
cutting or trimming. First print an index to identify the photos on the memory card 
(as described on page 19). Then choose the pictures you want to print. 

1. Load paper as follows:

■ If you’re using EPSON Premium Glossy, Semigloss, or ColorLife Photo 
Paper, load one sheet at a time.

■ If you’re using EPSON Matte Paper Heavyweight, Photo Paper, or Glossy 
Photo Paper, you can load up to 20 sheets at a time.

■ If you’re using EPSON Photo Quality Ink Jet Paper, you can load as many 
sheets as necessary, up to the arrow mark on the left edge guide.

Slide the left edge guide 
against the paper

Make sure the printable 
side of the paper is face up
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22 Printing Without a Computer

2. In the Print Mode menu, select One. (If you want to print enlargements of several 
photos, select Set.)

3. At the Paper Type menu, select either Glossy or Matte, depending on the type of 
paper you’re using.

■ If you’re using EPSON Photo Paper or Glossy Photo Paper, press the  
button and hold it until PP flashes on the Select Photo menu. 

■ If you’re using EPSON Photo Quality Ink Jet paper, press the
 button and hold it until SF (SuperFine) flashes on the Select Photo menu. 

4. In the Paper Size menu, select either 5 x 7, 8 x 10, or Letter.

5. In the Page Layout menu, select  for borderless prints, or  for prints with 
white borders. 

(If you’re using DPOF, skip to step 7.)

6. At the Select Photo menu, press the  button to select the picture you want to 
enlarge. 

If you want to enlarge more than one picture, press the round Select Photo 
button for each one you want. Press the Select Photo button again to print more 
than one copy of an enlargement.

7. At the Copies menu, press the  button to set the number of copies you want to 
print.

8. In the PhotoEnhance menu, select On (if your camera supports PRINT Image 
Matching or to improve brightness and contrast) or Off. 

9. Press the large green Print button. Your enlargement is printed.

Note: If you’re printing more than one glossy enlargement, you’ll see PE flash on 
the control panel after you print. Load another sheet, then press the b 
maintenance button to continue. 

Keep your pictures and unused paper away from high temperatures and humidity and 
out of direct sunlight. See page 12 for more information about storing and displaying 
your pictures.
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Printing Multiple Photos on a Sheet

You can print 2, 3, 4, or 20 photos on one sheet of paper. The printer automatically 
sizes your photos to fit the layout you choose on any size paper—from letter-size to 
4 × 6. See page 24 for a list of photo sizes on various paper sizes. 

You can print multiple copies of a single photo, a set of photos, or print all the photos 
on your memory card in multi-photo layouts. 

First print an index to identify the photos on the memory card (as described on 
page 19). 

1. Load paper in the printer.

2. Select your Print Mode, Paper Type, and Paper Size. 

Note: If you’re using Photo Paper or Photo Quality Ink Jet paper, see page 22 for 
instructions on selecting the Paper Type. 

3. In the Page Layout menu, select one of the following:

to print two photos on each sheet of the selected paper

to print four photos on each sheet of the selected paper

to print three photos on each sheet of the selected paper (the first photo may 
be larger on some paper sizes)

to print one photo 20 times or 20 photos on each sheet of the selected paper. 
If you print 20 different photos, the photo number and date are also printed. 

(If you’re using DPOF, skip to step 7.)

4. At the Select Photo menu, press the  button to select the picture or pictures you 
want to print. 

If you want to print more than one picture, make sure Set is selected in the Print 
Mode menu, then press the round Select Photo button for each photo you want. 
Press the Select Photo button again to print more than one copy of a picture. 

5. At the Copies menu, press the  button to set the number of copies you want to 
print. 

6. In the PhotoEnhance menu, select On (if your camera supports PRINT Image 
Matching or to improve brightness and contrast) or Off. 
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24 Printing Without a Computer

7. Press the large green Print button. Your photos are printed.

Note: If you’re printing more than one page, you may see PE flash on the control 
panel when your paper runs out. Load more paper, then press the b 
maintenance button to continue. 

Keep your pictures and unused paper away from high temperatures and humidity and 
out of direct sunlight. See page 12 for more information about storing and displaying 
your pictures.

When you print multi-photo layouts, your photos are sized to fit standard frames and 
wallet inserts, as shown in the following tables:

Paper size

Page 

layout

Size of each 

photo (inches) Paper size

Page 

layout

Size of each 

photo (inches)

Letter 8 × 10 5 × 7 5 × 7

7 × 5 4 × 6

3.5 × 5 3.5 × 2.5

5 × 3.5 2 × 2

2 × 2 3.5 × 2.5 or 
2 × 2

4 × 6 4 × 6 1.25 × 0.88

3.5 × 5 8 × 10 8 × 10

3.5 × 2.5 5 × 7

1.5 × 2 6 × 4

2 × 1.5 2.5 × 3.5

0.91 × 0.67 6 × 4 or 
3.5 × 2.5

4-inch wide 
roll

4 × 6 1.5 × 1.5
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Printing Snapshots on Roll Paper

You can print up to 52 borderless snapshots at a time on roll paper. First print an 
index to identify the photos on the memory card (as described on page 19). Then 
follow the instructions below to load roll paper and print.

Tip: It’s a good idea to check your ink levels before you print on roll paper. See 
page 86 for instructions. Replacing cartridges while roll paper is loaded can smear 
the paper.

Loading Roll Paper 

1. Make sure the roll paper adapter is attached to the printer as described on the 
Start Here sheet.

2. Insert both roll paper holders into the roll.

Make sure the edge of the paper is cut straight 
across. A diagonal cut may cause paper feed 
problems. If necessary, trim the paper. 

3. To avoid paper feeding problems, flatten the paper. 

Use a folded sheet of paper. Roll the paper inside the sheet, as shown below.

USE
NEW
ILLO
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26 Printing Without a Computer

4. Remove the paper support and lower the output tray. Make sure the printer is 
turned on.

5. Insert the tabs on the roll paper holders into the slots at the back of the printer as 
shown.

6. Feed the end of the paper into the printer as far as it will go, then slide the left 
edge guide against the paper.
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7. Hold the paper in place while you press the z roll paper button. The paper feeds 
into the printer.

Caution: Be careful not to get fingerprints on the paper. 

8. Open the printer cover and make sure the paper is feeding straight into the 
printer. If it is not straight, press and hold the z roll paper button to eject the 
paper. The error light comes on. Press the z roll paper button again to clear the 
error, then repeat steps 6 and 7.

Printing Your Pictures on Roll Paper

1. In the Print Mode menu, select Set. (If you want to print all the pictures on the 
card, select All.)

2. In the Paper Type menu, select Glossy.

3. In the Paper Size menu, select 4" Roll. Page Layout is automatically set to  for 
borderless prints. (You can print only borderless photos on 4” roll paper.)

If you want to print all the photos on the card (or you’re using DPOF), skip to 
step 5.

4. In the Select Photo menu, press the  button to 
display your picture numbers. For each picture you 
want to print, press the round Select Photo 
button. 

The number 1 appears on the Copies menu. (Press 
the Select Photo button again if you want to print 
more than one copy of a picture.) 
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28 Printing Without a Computer

5. In the PhotoEnhance menu, select On (if your camera supports PRINT Image 
Matching or to increase brightness and contrast) or Off. 

6. Press the large green Print button. Your pictures are printed. 

7. When the printer stops, press and release the z roll paper button. The paper 
feeds forward, and you see a line showing where to cut it. You see the  code on 
the control panel.

8. Cut the paper on the line and remove your pictures. 

9. Do one of the following:

Caution: To avoid paper feeding problems, make sure you follow these 
instructions to continue printing or remove the roll paper. Make sure you replace 
the roll when it has less than 8 inches of paper left.

■ If you want to continue printing on roll paper, press the z roll paper button. 
The paper feeds back into the printer. Follow the steps on page 27 to continue 
printing.
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■ If you’re finished printing on roll paper, press the z roll paper button and 
hold it down for about three seconds. The paper feeds all the way back, so you 
can remove it. You see the  code on the control panel.

Press the z roll paper button to clear the error code.

Remove the roll paper holder from the printer. Then remove the paper roll from the 
holder and store it in the original package. 

Keep your pictures and unused paper away from high temperatures and humidity and 
out of direct sunlight. See page 12 for more information about storing and displaying 
your pictures.

Enhancing Photos and Using Filters

The EPSON Stylus Photo 825 lets you enhance your photos even without a 
computer. Several different types of enhancement are available:

■ If your camera supports PRINT Image Matching, you can use the PhotoEnhance 
setting to automatically match your captured images.

■ Without PRINT Image Matching, you can still use the PhotoEnhance feature to 
improve any picture’s contrast, saturation, and color balance.

■ If you find that your pictures are too light or too dark, you can use the Brightness 
button to fix them.

■ You can print with special filters to enhance an individual photo’s sharpness, 
contrast, brightness, and other qualities. You can also use filters to print a photo 
in black and white or in sepia (brown) tones. If you’re using PRINT Image 
Matching, filters (and brightness adjustments) are applied after PRINT Image 
Matching.

Note: Filters and enhancements affect only your printed pictures. They do not 
change your original image files.
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Using PhotoEnhance

You can use the PhotoEnhance feature to apply PRINT Image Matching or optimize 
brightness and contrast—in all printing modes except Index, and with all types of 
paper.

1. Select your Print Mode and other settings.

2. When you’re ready to print, make sure On is 
selected in the PhotoEnhance menu.

3. Press the large green Print button. Your photos are printed.

When you turn on the PhotoEnhance setting, it applies to all pictures in your print 
job. 

Adjusting Brightness

You can make your photos lighter or darker using the Brightness button. The setting 
you choose applies to all pictures in your print job—in all printing modes except 
Index, and with all types of paper.

1. Select your Print Mode and other settings.

2. When you’re ready to print, press the Brightness 
button. The word Brightness flashes on the Select 
Photo menu, and the number 0 is displayed.

3. Press the  button to make your pictures 1 level lighter (1 is displayed). Press the 
 button again to make your pictures 2 levels lighter (2 is displayed).

Press the  button once or twice to make them 1 or 2 levels darker (-1 or -2 is 
displayed). 

4. Press the Brightness button again to save the setting. The word Brightness 
stops flashing, and your selected (or total) photo number is displayed again.

5. Press the large green Print button. Your photos are printed.
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Using Filters

You can use filters to enhance or add special effects to individual photos. Nine filter 
effects are available, as listed below. (Four of the filters have the same effect as the 
brightness settings.) Filters work in all print modes except Index, on all types of paper.

1. Select your Print Mode and other settings and select the photo(s) you want to 
print.

2. Press and hold the Brightness button until Filter 
No. flashes on the Copies menu. 

3. In the Select Photo menu, use the  button to select 
the number of the picture that you want to print with a filter.

4. In the Copies menu, press the  button to select the filter number you want:

1: black and white 6: 1 level darker
2: sepia (brown tones) 7: 2 levels darker 
3: high contrast 8: more vivid
4: 1 level brighter 9: sharper
5: 2 levels brighter

Brightness level -2 (filter 7) Brightness level -1 (filter 6)

Original photo

Brightness level 1 (filter 4) Brightness level 2 (filter 5)
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32 Printing Without a Computer

If you want to apply the same filter to all the photos you’re printing, press and 
hold the Brightness button again until ALL appears on the select Photo menu. 
Then skip to step 7.

5. Repeat steps 3 and 4 for all the pictures you want to print with filters. 

6. Press the Brightness button again to save your settings. The filter number 
disappears, but it remains in effect. 

7. Press the large green Print button. Your photos are printed.

Printing Stickers 

You can turn your favorite picture into photo stickers, and even add a fun frame 
around each one. First print an index to identify the photos on the memory card (as 
described on page 19). Make sure you have a package of EPSON Photo Stickers 
(S041144). 

1. Follow the instructions in the package to load a sheet of stickers with the two 
support sheets beneath it. 

Make sure the cut 
corner is here
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2. In the Print Mode menu, select one of the following:

to print all your photos on a sheet of stickers (or several sheets, if you have 
more than 16 photos)

to print one selected photo on all stickers

to print a group of selected photos 

You don’t need to set the paper type or size. If you’re printing all photos, skip to 
step 4.

3. In the Select Photo menu, press the  button to display your picture numbers. 
For each picture you want to print on stickers, press the round Select Photo 
button. 

4. Choose your Quality and PhotoEnhance settings. 

5. Go back up to the Page Layout menu. Press and 
hold the  button until the layout icons disappear 
and SE flashes on the Select Photo menu. 

6. Press the large green Print button to print your 
stickers.

Adding Fun Frames to Your Stickers

You can print photo stickers with any of these 5 frames. 

Follow steps 1 through 5 above to set up your stickers. Then follow these steps to add 
frames:

1. Press and hold the Select Photo button until Frame No. flashes on the Copies 
menu.

2. For each photo sticker you’re printing, press the  button to select the frame you 
want, as shown above. 

1 2 3 4 5
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3. Repeat step 2 for each photo number. You can select a different frame for each 
sticker.

4. Press the Select Photo button again to save your settings. The frame numbers 
disappear, but they remain in effect. 

5. Press the large green Print button to print your framed stickers.

Printing Special Layouts

You can turn a normal landscape into a panoramic photo, or take a portrait and print 
an “ID sheet” with 8 different sizes on one piece of paper. 

1. Select your Print Mode and other settings and select the photo(s) you want to 
print.

2. In the Page Layout menu, press and hold the  
button until the layout icons disappear and Id 
appears on the Select Photo menu. 

If you want to select PA (panoramic), press the  
button again.

3. Press the large green Print button to print your photos.

Panoramic ID sheet
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Printing From Windows or a Mac

When you print from your computer, your EPSON Stylus Photo 825 works like any 
other printer. You can edit and enhance your photos, create photo greeting cards or 
calendars, and then print them out. Before you start, make sure your printer software 
is installed as described on the Start Here sheet.

When you insert a memory card in your printer, you can have all the photos 
automatically copied to your computer. See page 10 for more information. When you 
remove a memory card, make sure you follow the instructions on page 11.

Follow the instructions in these sections to print using all your printer’s features:

■ “Loading Paper” on page 36

■ “Basic Printing in Windows” on page 38

■ “Basic Printing on a Macintosh” on page 40

■ “Customizing Your Print Settings” on page 45

■ “Selecting the Correct Paper or Media Type” on page 49

■ “Printing BorderFree Photos” on page 50

■ “Using PRINT Image Matching” on page 51

Tip: Whenever you print, make sure you:

■ Use the right paper.

For the best-looking photos, most vivid colors, and greatest detail, always use 
genuine EPSON papers and EPSON ink. 

■ Choose the right printer settings for the paper.

Your printer automatically adjusts itself for the type of document and paper 
you’ve selected, so make sure your printer settings are correct for the document 
you’re printing and the paper you’ve loaded.
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36 Printing From Windows or a Mac

Loading Paper

Make sure your printer and computer are turned on. 

Place your paper against the right edge of the sheet feeder and slide the left edge guide 
against the paper. Don’t push the paper deeper into the feeder. 

Follow these guidelines when loading paper:

■ Load the printable side face up. It’s usually whiter or brighter than the other side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Don’t load paper above the arrow on the left edge guide.

Loading Envelopes

You can load up to 10 envelopes at a time, top edge first and printable side up. Place 
the envelopes against the right edge of the sheet feeder and slide the left edge guide 
against them. 

Tip: For best results, press each envelope flat before loading it, or load one 
envelope at a time.

Load paper only 
up to this arrow

Slide the left 
edge guide 
against the paper
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Set the thickness lever to the + position. (Remember to move the thickness lever back 
to the 0 position when you’re done printing envelopes.) 

Before you print, make sure you choose the correct envelope size as the paper Size 
(Windows) or Paper Size (Macintosh) setting. See page 39 (Windows), page 40 
(Macintosh OS 8.6 to 9.x), or page 42 (Macintosh OS X).

Load with the 
printable side up

Set the 
thickness lever 
to the + position
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Basic Printing in Windows

After you create a document in a software program, follow these steps to print it using 
the basic printer settings: 

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo 825 is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to open 
your printer 
software

Make sure your printer is selected here

���������	�
�������������������������������������



Printing From Windows or a Mac 39

4. Select the following settings on the Main tab in your Printing Preferences 
window: 

Tip: For more information about printer settings, click the or Help button.

5. You return to the Print window. Click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or resume printing. You can also see how much 
ink you have left. 

2 Select your paper 
type (see page 49)

5 Click OK

Draft: for rough drafts with 
reduced print quality

Text: For text-only 
documents with higher 
text quality

Text & Image: For 
documents with text and 
images with higher quality

Photo: For photos and 
graphics with good quality 
and speed

Best Photo: For photos or 
graphics with high print 
quality

3 Select your 
paper size

4 Select your 
document or 
image orientation

1 Select the type of document you’re printing:

Click to cancel printing

Click to pause or 
resume printing
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Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you want, 
you can change the Windows default printer settings for all your programs.

1. Right-click the  printer icon in the lower right corner of your screen (taskbar). 

2. Select Printer Settings. You see the window shown on page 39.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Basic Printing on a Macintosh

After you create a document in a software program, follow the steps in one of these 
sections to print it using the basic printer settings: 

■ For Macintosh OS 8.6 to 9.x applications, see the next section.

■ For Macintosh OS X applications, see page 42.

Printing with OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described on 
the Start Here sheet.

1. From the File menu, select Page Setup. Select the following settings:

2. Click OK to close the Page Setup window.

1 Make sure you see SP 825 

2 Select your paper size

3 Select the orientation of your 
document or image
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3. From the File menu, select Print. Select the following settings:

Tip: For more information about printer settings, click the button.

4. You can also do the following:

■ Click  to reduce/enlarge your printed image, print multi-page layouts, or 
add a watermark.

■ Click  to control background printing. 

■ Click , then click Preview to preview your printout.

■ Click  to check your ink levels. 

5. Click Print. 

6. If you turned on background printing, you can select EPSON Monitor3 from the 
Application menu in the upper right corner of the screen. You see the EPSON 
Monitor3 window:

Note: If you’re not using background printing and you need to cancel printing, 
hold down the J key and press the . (period) key.

4 Select Quality or Speed 
(for faster printing)

1 Select your paper type 
(see page 49)

3 Select Automatic mode

2 Select Color for color 
documents and black 
and white photographs

Select your print job, 
then click here to 
cancel printing

Click to check 
ink levels
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Printing with OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps on page 40 instead.)

Before you begin, make sure you added your printer to Print Center as described on 
the Start Here sheet.

1. Open a photo or document.

2. From the File menu, select Page Setup.

3. Select the following Page Setup settings as necessary:

4. When you’re finished, click OK.

5. Select Print from the File menu. You see a screen like this:

Select SP 825 
from the 
Format for 
pop-up menu

Select the Paper Size, 
Orientation, and any 
other settings you 
want to use

Click here and 
select Print 
Settings 
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6. Select Print Settings from the pull-down menu.

7. Select the following Print Settings as necessary:

Tip: For more information about printer settings, click Help. The OS X printer 
driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh 
printer driver described in this book.

8. You can also choose other print settings by selecting these options in the 
pull-down menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software

■ Summary, to view a list of all your selections

■ Save Custom Setting, to save your selections for future use.

9. Click Print.

4 Select Quality or Speed 
(for faster printing)

1 Select your paper type 
(see page 49)

3 Select Automatic mode

2 Select Color for color 
documents and black 
and white photographs
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10. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock on the bottom of your desktop. You see a screen like this:

11. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job.

■ Click the print job, then click Hold to pause printing.

■ Click a print job marked “Hold” and click Resume to resume printing.

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs.

12. When you’re finished, close Print Center.
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Customizing Your Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

Customizing Windows Print Settings

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window. Read the warning and click Continue. The Basic settings change to the 
Advanced settings.

2. Select the following advanced settings as necessary:

3. Once you’ve finished selecting advanced settings, you can: 

■ Click OK to save your settings, return to the Print dialog box, and print.

■ Click the Basic button to return to the Basic settings.

■ Click the Page Layout tab and continue with step 4 to select layout options.

Note: For more information about advanced settings, or instructions on saving 
them as a group so you can reuse them later, click the Help or button. If you 
want to use the Advanced screen each time you access your printer settings, 
select Show this screen first.

1 Select Paper & Quality 
options as necessary

Click here to select 
Photo RPM for the 
best print quality on 
certain paper types

2 Select Print Options 
as necessary

Click here to select 
Black Ink Only 
printing

3 Select a color 
management 
method 

To choose 
No Color 
Adjustment, click 
ICM first
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4. Select the following page layout settings as necessary:

Note: For more information on page layout settings, click the Help or button.

5. Click OK to save your settings, return to the Print dialog box, and print.

1 Select image position 
options here

2 Select image resizing 
options here; these 
affect only your 
printed image

3 Add a watermark to 
printed page here

4 Select multi-page 
document options 
here and here

To print a large 
image on several 
sheets to make a 
poster, select 
settings here
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Customizing Macintosh Print Settings

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it. 

Note: For more information on custom settings, click Help (OS X) or 
(OS 8.6 to 9.x).

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings, click Custom and then click Advanced Settings 
(OS X) or Advanced (OS 8.6 to 9.x).

Macintosh 

OS 8.6 to 9.x

Macintosh OS X

Click Custom, then choose:

Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the 
Custom Settings list

Click Custom, then choose:

Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the 
Custom Settings list
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4. Select these advanced settings as necessary:

Note: For more information on advanced settings, or instructions on saving them 
as a group so you can reuse them later, click Help (OS X) or (OS 8.6 to 9.x).

5. OS 8.6 to 9.x: Click OK to save your settings, then click Print.

OS X: Click Print.

3 Select color management 
settings here

1 Click here to select Photo RPM 
for the best print quality on 
certain paper types

2 Select various print 
options here

Macintosh OS 8.6 through 9.x

2 Select various print options here

3 To select color management 
settings, select Color 
Management from the Print 
Settings pull-down menu

Macintosh OS X

1 Click here to select Photo RPM 
for the best print quality on 
certain paper types
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Selecting the Correct Paper or Media Type

Select the correct Type or Media Type setting so your printer 
knows what kind of paper you’re using and adjusts the ink 
coverage accordingly.

For this paper . . . Select this Type or Media Type setting

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Photo Paper Photo Paper 

EPSON Glossy Photo Paper

EPSON All Purpose Glossy Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

EPSON Panoramic Glossy Photo Paper

Glossy Photo Paper

EPSON Premium Glossy Photo Paper 
(including roll paper)

EPSON Premium Luster Photo Paper 
(including roll paper)

EPSON Semigloss Photo Paper (including 
roll paper)

Premium Glossy Photo Paper

EPSON Photo Stickers

EPSON Photo Quality Glossy Film

Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies

EPSON ColorLife Photo Paper ColorLife Photo Paper
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Printing BorderFree Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although BorderFree printing is a bit slower (especially near the 
edges), you get beautiful snapshots or enlargements, without trimming. (Not available 
with Macintosh OS X.)

You can print BorderFree photos on a variety of paper types and sizes. See the inside 
back cover for a complete list of paper types, sizes, and ordering information.

Follow these steps to print BorderFree photos:

1. Start your printing application and open your photo file.

2. Access the printer settings window (see page 38 for Windows or page 41 for 
Macintosh OS 8.6 to 9.x).

3. Windows only: Select Photo or Best Photo as the Quality Type setting.

4. Windows: Check the 
Sheet or Roll paper 
button and then select your 
paper type in the Type 
pull-down menu. Click the 
Borderless checkbox. 
Then select your paper size 
in the Size pull-down 
menu.

Note: The paper types 
available depend on whether 
you selected Sheet or Roll.

Macintosh: Click OK. Then 
click File > Page Setup. 
Click the Borderless 
checkbox, then select the 
correct Paper Size and 
Paper Source setting.
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5. Select Portrait or Landscape as the Orientation setting.

6. Click OK.

7. Windows: Click OK or Print.

Macintosh: Click File > Print, then click Print.

Using PRINT Image Matching

With PRINT Image Matching, special print instructions are saved in your digital 
photo files. For example, macro mode pictures might include print commands for 
sharpness and clarity, while portrait mode pictures might emphasize soft focusing and 
subtle flesh tones. If your digital camera supports PRINT Image Matching, you can 
use this technology when you print with:

■ Film Factory, as described below, or 

■ P.I.M. Plug-in for Adobe Photoshop, as described on page 56, or

■ ArcSoft PhotoImpression (see the help utility that comes with the program for 
printing instructions).

Using Film Factory

If your digital camera supports PRINT Image Matching or Exif Print, you can use 
these technologies when you print with Film Factory to ensure the most accurate 
image reproduction (not available with Macintosh OS X). You can also use Film 
Factory to organize, retouch, and print non-P.I.M. and non-Exif Print digital images.
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Opening Your Photos in Film Factory

Follow these steps to print P.I.M. photos with Film Factory:

1. Start Film Factory. You see the main Film Factory screen:
 

Note: If you need help with Film Factory, select it from the Help menu or check 
the on-screen Getting Started Guide that was installed with Film Factory.

2. Select a “roll of film” or click the Roll button and select New Roll.

If you created a new roll or you want to add photos to an existing roll, you need to 
import the photos. Click the Import button, then:

■ Click From File to import a photo from your computer’s hard drive.

■ Click From Removable Media to import a photo from a disk or CD-ROM. 

■ Click From PC Card to import a photo from a PC card in a card reader.

■ Click From Twain Device to import a photo from a scanner or digital 
camera. If your device is already selected, the software will open. If not, click 
Import Settings, and select your scanner or digital camera. (Not applicable 
to OS X.)

Click Roll to create 
a new roll, or . . .
click an existing roll

PRINT Image 
Matching 
photos are 
marked here
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3. If your photos were taken with a digital camera that supports PRINT Image 
Matching, the P.I.M. logo appears in your photo thumbnails. Right-click 
(Windows) or Ctrl-click (Macintosh) a photo thumbnail to display information 
about the P.I.M. and/or Exif Print data in the photo file. (If you retouched a 
PRINT Image Matching photo, the P.I.M. logo may not appear.)

4. Click the photo you want to print, or click the All button at the top of the screen 
to select all the photos in a roll. Then go to step 6.

5. Click a button on the left to select a print option. For 
example, click the Standard Prints button. You see buttons 
for each step you need to follow, as shown. 

6. Click Import & Retouch to retouch or edit your photo, if 
necessary.

7. When you’re ready to print, continue with the steps in the next section.

Note: You can rotate, trim, and correct for red eyes and still 
retain P.I.M. or Exif Print data with your photograph. 
However, if you adjust other settings, such as brightness 
and color, these settings are not retained. For this reason, it 
is a good idea to make a copy of the original image before 
you edit it.
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Printing Your Photos

1. When you’re ready to print, click the Print Assignment button. You see this 
screen:

2. Windows and Macintosh OS 8.6 to 9.x: Select these options in the Printer 
Settings box at the bottom of the screen, in this order:

Macintosh OS X: Click the Properties button. Select your printer in the 
Format for menu, select the correct Paper Size setting, and click OK. 
(BorderFree printing is not available with Film Factory on OS X.)

3. If you want to print the current date with your photo, click the Print Date box.

Click to print the 
date with your photo

Select your printer 
settings here

1 Make sure your printer is selected 

2 Select your paper source

3 Select your paper size

4 Select a Media Type
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4. Click the Print button on the left side of the screen. You see more options:

5. If your photo doesn’t look right in the preview, click the Back button to change 
your settings. (Click the Detailed Preview button for a closer look.)

6. Select the number of copies you want to print. 

7. Leave the PRINT Image Matching and/or Exif Print box checked for the best 
results when printing photos containing P.I.M. and/or Exif Print data. (Not 
applicable to OS X.)

8. Click the Print button at the top of the screen. 

■ Windows: Your pictures are printed.

■ Macintosh OS 8.6 to 9.x: You see the Print window; click Print. Your 
pictures are printed.

■ Macintosh OS X: You see the Print window. Select Print Settings from the 
Copies & Pages pull-down menu. Then select your Media Type and other 
print settings as necessary, and click Print.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture 
frames. Keep your pictures and unused paper away from high temperatures, humidity, 
and direct sunlight. Make sure you return unused paper to its original package. 

Select the number of copies 
you want to print 

Leave these boxes checked for the 
best printed output using P.I.M. 
and/or Exif Print data, if available

���������	�
�������������������������������������



56 Printing From Windows or a Mac

Using the P.I.M. Plug-in for Adobe Photoshop

The P.I.M. Plug-in for Adobe Photoshop allows you to retain the P.I.M. image quality 
when you import JPEG files from your P.I.M.-enabled digital camera. The P.I.M. 
Plug-in works with Photoshop 7.0, 6.0, and Photoshop Elements 1.0. You’ll also need 
to use the ICC profiles for your printer that are installed with the plug-in (Windows) 
or the printer driver (Macintosh). (Not available for Macintosh OS X.)

Photoshop doesn’t retain the PRINT Image Matching information separately in the 
JPEG’s header file when you import your P.I.M. image. Instead, it converts that 
information in the file and embeds a color space called EPSON RGB 2001. This 
profile supports all the P.I.M. color advantages and enhancements. 

You can crop, rotate, resize, work with layers, play with filters, and even make 
selective color adjustments to the P.I.M. image while retaining P.I.M. quality. 
However, you won’t benefit from global color adjustments (such as Auto Levels, Auto 
Contrast, Auto Color, etc.). Also, if you save the image and then try to use your new 
Photoshop file in another P.I.M.-enabled software program, it won’t be recognized as 
a P.I.M. image. Copy the original file and make your changes to the copy so the 
original retains its P.I.M. information for use in other programs.

Importing a P.I.M. Image

1. If you’re using Photoshop Elements, change your color settings before importing 
a P.I.M. image. Select Color Settings from the Edit menu, then select Full color 
management - optimized for Print and click OK.

2. Open the File menu and select Import > 
PRINT Image Matching. You see a 
window like this:

3. Select the folder containing your P.I.M. 
images. (In Windows, all your JPEG files 
are listed; on a Macintosh, only P.I.M. 
files appear.)

4. Select the P.I.M. image you want to 
import.

5. To see a preview of the selected P.I.M. 
image, check the PRINT Image 
Matching Preview box.
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6. Click the Open button. Your image opens and the window remains on the screen.

7. Select and open more P.I.M. images, or click Cancel to close the Open PRINT 
Image Matching file window. (If you don’t want the window to remain on the 
screen after you open a file, uncheck Import consecutively.)

8. Follow the steps in the next section to print your P.I.M. image.

To keep the P.I.M. header information intact for use in other P.I.M.-enabled 
programs, keep the original file; don’t use the Photoshop Save command. Instead use 
Save As to rename the file. It won’t contain P.I.M. header information, but will 
retain P.I.M. image quality, as long as the file is saved with the ICC profile embedded. 

Note: If you overwrite your original file, you will lose all P.I.M. header information.

Printing a P.I.M. Image

P.I.M. images are converted into the EPSON RGB 2001 color space. To retain 
P.I.M. quality and enhancements, don’t change the color space.

Note: The illustrations in the sections below show Macintosh screens; Windows 
screens will look different, but the settings are the same.

1. Open the File menu, then:

Photoshop 7.0 or Elements: Select Print Preview > Show More Options > 
Color Management.

Photoshop 6.0: Select Print.

You see the window shown on the next page.

Note: If you see this screen, 
select Use the embedded 
profile and click OK.
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2. In the Source Space box, make sure the EPSON RGB 2001 option is selected.

3. In the Print Space box, select the SP825 profile for the paper you’re printing on. 
We recommend Perceptual as the Intent setting.

4. Photoshop 7.0 or Elements: Click Print. You see the printer settings window.

Photoshop 6.0: Go to step 5.

Note: In Windows, click Setup, then select your printer and click Properties or 
Preferences to select these settings.

5. Windows only: Select Photo or Best Photo.

Make sure this source is selected

Select the profile for your printer and paper

Photoshop 7.0/Elements Photoshop 6.0

Select your paper

Click Custom

Click Advanced
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6. Select the paper you’re printing on as the Type (Windows) or Media Type 
(Macintosh) setting.

7. Windows: Click the Advanced button. The Basic settings change to the 
Advanced settings.

Macintosh: Under Mode, click Custom, then click the Advanced button. You 
see the Advanced screen.

8. Windows: Select ICM, then select No Color Adjustment and click OK.

Macintosh: Select No Color Adjustment and click OK.

9. Continue clicking OK (Windows) or click Print (Macintosh) to print your photo.

No Color AdjustmentWindows

Macintosh
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Maintaining Your Printer

Follow the instructions in this chapter to keep your printer working at its best and 
prepare it for moving, if necessary.

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 63

■ “Aligning the Print Head” on page 68

■ “Cleaning the Printer” on page 69

■ “Transporting the Printer” on page 70

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to 
clean the print head. This unclogs the nozzles so they can deliver ink properly. Print 
head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility 
(available only when the printer is connected directly to your computer, not over a 
network). 

You can also clean the print head by holding down the b maintenance button on the 
printer for three seconds (when the red b error light is off).

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline, so turn it on at least once a month to maintain good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red b error light is 
off. (If the red light is flashing or on, you may need to replace the ink cartridge; 
see page 63 for details.)

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning. 

Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the 
Utility button, then click the  Head Cleaning button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 825 in the printer list, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to 
clean the print head. 

Cleaning takes about 30 seconds, during 
which the printer makes some noise and 
the green Processing light flashes.

4. When the green Processing light stops flashing, make sure paper is loaded in the 
printer and click Print nozzle check pattern. Then click Print. The nozzle check 
pattern prints (see the next section for details).

5. If the nozzle check pattern has no gaps or lines, click Finish.

If the pattern is missing lines or has gaps, click Clean to clean the print head 
again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions beginning on page 91. You can also turn off the printer and wait 
overnight—this allows any dried ink to soften—and then try cleaning the print 
head again. 

Caution: Never turn off the printer while 
the green Processing light is flashing, 
unless the printer hasn’t moved or made 
noise for more than 5 minutes.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. Each staggered horizontal and straight 
vertical line should be complete, with no gaps in the dot pattern, as shown below:

■ If your printout looks okay, you’re done. 

■ If you see any white lines or gaps (as shown), clean the print head again; see 
page 62 for instructions. 

Replacing an Ink Cartridge

When the red b error light flashes, an ink cartridge is low on ink. This is a good time 
to make sure you have a new cartridge handy. When the red b error light stays on, 
you may need to replace one of the cartridges.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red b error light is off.

Note: The red b error light also comes on if your paper runs out or is jammed, so 
make sure to check your paper before replacing a cartridge.

Checking the Ink Supply

Check the control panel to see which cartridge is low or empty:

Ink Low—Black Ink Low—Color Ink Empty—Black Ink Empty—Color
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If you’re printing from your computer, you can 
also do one of the following:

■ Windows: Double-click the  icon in the 
lower right corner of your screen. If a 
cartridge is low on ink, you’ll see a window 
like this: 

Or double-click the Ink Monitor icon 
to check your ink levels. Click Buy Now to 
launch your web browser and order ink 
cartridges online.

■ Macintosh:
OS 8.6 to 9.x: Choose File > Print. Click the 

ink icon. 

OS X: Choose Applications > EPSON Printer 
Utility > SP825 > Status Monitor.

You see a window like this:

Click a cartridge image to display information about 
the cartridge.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.

When you need new ink cartridges, contact your dealer, or call the EPSON Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral. 

Black ink cartridge: T007201 

Color ink cartridge: T008201 

Boxes may be labelled T007 (black) or T008 (color).
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Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise the ink 
remaining in the print head nozzles may dry and clog the nozzles.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing (the Processing light should 
be on, but not flashing), then open the printer cover.

2. Press the e ink cartridge replacement 
button. The print head moves to the center 
and the Processing light flashes.

3. The color cartridge is on the right and 
the black is on the left. Pull up the ink 
cartridge clamp. The cartridge rises up 
from its holder.
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4. Lift the cartridge out of the printer and 
dispose of it carefully.

5. Unwrap the new ink cartridge. Then remove 
only the yellow tape seal on top.

Caution: You must remove the yellow tape 
from the top of the cartridge or you will 
permanently damage it. 

Don’t try to remove the clear seal underneath 
the cartridge.

Don’t touch the green circuit board on the back of the cartridge; you may inhibit 
normal operation and printing. 

6. Tilt the new cartridge toward 
you slightly as you insert it.

black cartridge color cartridge

hooks
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Lower the cartridge so that the tabs rest on the hooks as shown:

7. Press down firmly on the ink 
cartridge clamp until it snaps in 
place.

8. If you need to replace the other ink 
cartridge, repeat steps 3 through 7 
before continuing with step 9.

9. Press the e ink cartridge 
replacement button and close the 
printer cover. The printer begins 
charging the ink delivery system.

The Processing light flashes, and the 
printer makes noise. Charging takes 
about one minute. When it’s finished, 
the Processing light stops flashing 
and stays on, and the red b error 
light goes out.

Caution: Never turn off the printer while the Processing light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.

Caution: Don’t place the cartridge 
under the hooks; you may damage 
the clamp when you close it. 
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Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see white or black horizontal 
banding, you may need to align the print head. 

Note: Your printer must be connected directly to your computer (not over a 
network) to use the Print Head Alignment utility. 

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment. 

Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the 
Utility button, then click the  Print Head Alignment button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select SP 825 in the printer list, click OK, and select Print Head 
Alignment.

4. Follow the instructions on the screen to print 
an alignment pattern. You see this window:

5. On the test page, select the pattern with the 
two vertical lines most precisely printed on 
top of each other. You may need to use a 
magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. Then enter the number of the best 
pattern for each row in the corresponding boxes on the screen. Then click Finish.

If you can’t find an aligned pattern, click Realignment to print another test page, 
then repeat this step.
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. 
Follow these steps: 

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 

4. Clean ink out of the printer’s interior with a soft, damp cloth. 

Warning: Don’t touch the gears inside the printer.

Caution: Never use a hard or abrasive brush, or alcohol or thinner for cleaning; 
they can damage the printer components and case. 

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer. 

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

5. Use a soft, dry cloth to clean the display and optional preview monitor. Do not 
use liquid or chemical cleaners on these parts.
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or a similar one. Follow these steps:

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

1. Turn on the printer, wait until the print head locks in the far right position, then 
turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. If you still have the 
packing insert, slide it down into the area 
beside the ink cartridge holder and tape it to 
the printer case. If you don’t have the insert, 
just tape the cartridge holder to the printer 
case. Then close the printer cover.

5. Push in the output tray extension and close the tray.

6. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 61); if 
output is misaligned, align the print head (see page 68). 

Tape the ink cartridge 
holder to the printer case

Caution: Be sure to remove the tape 
and packing insert after installing the 
printer in its new location.
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Installing Your Printer Software

Before installing your printer software, follow the steps on the Start Here sheet to set 
up your printer and connect it to your computer.

If you’re using Windows XP, Windows 98, or Mac OS 8.6 to 9.x, follow the software 
installation instructions on the Start Here sheet.

If you’re using one of the operating systems below, follow the instructions in this 
chapter to install your printer software:

■ “Installing Printer Software on Mac OS X” below

■ “Installing Printer Software on Windows Me” on page 76

■ “Installing Printer Software on Windows 2000” on page 78

Installing Printer Software on Mac OS X

First you’ll install your printer software for OS X applications. You’ll install both a 
printer driver and a memory card driver, and restart your Macintosh after each one.

Then you’ll restart your Macintosh in OS 9.x and install your printer software for OS 
8.6 to 9.x applications.

Installing the Printer Driver for Mac OS X

1. Start up your Macintosh in OS X. (Make sure your printer is still on.)

2. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few 
seconds for the CD-ROM to be recognized.
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3. Select EPSON on your 
desktop. Then select the 
SP825 icon in the window 
that opens: 

4. If you have an administrator 
password, you see this screen:

5. Click the lock icon, then enter your 
password and click OK.

6. Click Continue, then read and agree to 
the license agreement to continue the 
installation.

7. Select the OS X drive or partition and 
click Continue.

8. When you see the Easy Install screen, 
click Install.

9. Follow the on-screen instructions to 
complete the installation and restart 
your Macintosh.

Then follow the steps in the next section to 
install the storage driver and additional 
software.

Select SP825

Click the lock icon

Click install

���������	�
�������������������������������������



Installing Your Printer Software 73

Installing Additional Software for OS X

1. After your Macintosh restarts, select the EPSONStorage icon. 

2. If you have an administrator password, click the lock icon, enter the password, 
and click OK.

3. Click Continue when you see this screen:

Then follow the on-screen instructions to 
select the OS X drive or partition, complete 
the installation, and restart your Macintosh.

4. After your Macintosh restarts, select to install Film Factory and follow the 
on-screen instructions. When you finish, click Quit to return to the Installer.

5. Select to install ArcSoft PhotoImpression and follow the on-screen 
instructions. Then click Quit to return to the Installer.

6. Select to install the Printer Manual on your desktop and follow the on-screen 
instructions.

7. If you have Photoshop 7, you can install the P.I.M. plug-in. Drag the PRINT 
Image Matching icon to the Photoshop Plug-in folder on your Macintosh.

8. Open the OS X Applications folder, then open the Utilities folder and select 
Print Center.

Note: If you see this screen, click Add.

If SP825 already appears in the Printer 
list, go to step 11.

9. At the Printer List screen, click Add Printer.
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10. Select EPSON USB, click 
SP 825(USB), then click Add.

Note: The printer must be connected to 
the computer and turned on.

Your printer appears on the printer list.

11. Close Print Center and start up your 
Macintosh in OS 9.x.

Follow the instructions in the next section to install the OS 9.x printer driver and 
optional software for your Macintosh Classic applications. (You don’t need to 
reinstall your printer manual.)

Installing the Printer Driver and Utilities for 
Mac OS 9.x

1. Leave in the CD-ROM as your Macintosh restarts in OS 9.x.

2. If you see this message, click Cancel.

3. Select EPSON on your desktop, if necessary. 
Then select EPSON in the window that opens.

4. Read and agree to the license agreement to 
continue the installation.

5. Click Install Printer Driver and Utilities 
and follow the on-screen instructions to 
install the software and restart your 
Macintosh. 

Then continue with the instructions in the 
next section.

Click Add
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Installing Additional Software for Mac OS 9x

1. After your Macintosh restarts, register your printer with EPSON as instructed.

2. Open the Chooser from the Apple menu. 
Select SP 825, then select your USB port 
and turn on background printing.

3. Close the Chooser.

4. Select EPSON in the window on your 
desktop to open the Install Menu again.

5. Click Install Optional Software. You see 
this menu:

6. Click the button for each program you want 
to install and follow the instructions on the 
screen.

If you see a message about installing 
QuickTime,® click Yes and follow the 
on-screen instructions. You don’t need a 
registration number.

7. When you’re finished installing software, close any open windows and click Back 
to return to the Install menu. Then click Exit. 

Remove the CD-ROM and keep it in case you need to reinstall any software later. 
You’re ready to print.
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Installing Printer Software on Windows Me

Before you start, make sure your printer is set up, connected to your computer, and 
turned on, as described on the Start Here sheet. Follow the instructions in the two 
sections below, first to install your printer driver and utilities, and then to install 
additional software.

Installing the Printer Driver and Utilities for 
Windows Me

1. Turn on your computer. 

2. Wait for Windows to detect your printer 
connection and display a screen like this:

Note: If this screen doesn’t appear, make sure 
your printer is turned on and connected.

3. Insert the EPSON CD-ROM in your 
CD-ROM or DVD drive and click Next.

4. Continue clicking Next or Finish until setup is 
complete. You see a message about installing additional 
software:

5. Click OK. When you see the license agreement, click 
Agree, then continue with the instructions in the next section to finish the 
installation.
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Installing Additional Software for Windows Me

After you accept the license agreement, you see 
this software installation screen:

1. Click Continue. Additional software is 
installed, then you see the EPSON 
PhotoStarter Setup.

2. Click Next and follow the on-screen 
instructions to accept the license agreement 
and install PhotoStarter. 

Do the same thing when you see the EPSON Card Monitor Setup.

3. When setup is complete, select Yes to 
restart your computer and click Finish. 

Leave in the CD-ROM as your 
computer restarts. You see the Optional 
Software menu:

4. Click the button for each program you want 
to install and follow the instructions on the 
screen.

5. If you see a message about installing 
QuickTime, click Yes and follow the 
on-screen instructions. You don’t need a 
registration number.

6. When you’re finished installing software, close any opened windows and click 
Exit.
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7. When you see the registration screen, register your printer with EPSON as 
instructed. Remove the CD-ROM and keep it in case you need to reinstall any 
software later. 

You’re ready to print.

Installing Printer Software on 
Windows 2000

Before you start, make sure your printer is set up, connected to your computer, and 
turned on, as described on the Start Here sheet. Installation takes place in several 
phases. Follow the instructions in the two sections below, first to install your printer 
driver and utilities, and then to install additional software.

Installing the Printer Driver and Utilities for 
Windows 2000

1. Turn on your computer.

2. Wait for Windows to detect your printer 
connection and display a screen like this:

Don’t click any buttons on the screen yet.

Note: If this screen doesn’t appear, make sure 
your printer is turned on and connected.

3. Put the EPSON CD-ROM in your 
CD-ROM or DVD drive and wait a few 
seconds for the CD-ROM to be recognized.

4. Click Next.
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5. Click the Search for option, then click 
Next.

6. Click CD-ROM drives (only), then click 
Next.

7. At the next screen, click Next. Installation 
proceeds automatically. 

8. When installation is complete, click Finish.

You see another New Hardware Wizard 
screen.

9. Click Next.

10. Click the Search for option, then click Next.

11. Click CD-ROM drives, then click Next.

12. At the next screen, click Next. Installation proceeds automatically. 

If you see this screen, click Yes to continue. 
Otherwise, driver installation will not be 
complete.
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13. At the final Found New Hardware Wizard screen, click Finish.

You see a message about installing additional software:

14. Click OK. When you see the license agreement, click Agree, then continue with 
the instructions in the next section to finish the installation.

Installing Additional Software for Windows 2000

After you accept the license agreement, you see 
this software installation screen:

1. Click Continue. Additional software is 
installed, then you see the EPSON 
PhotoStarter Setup.

2. Click Next and follow the on-screen 
instructions to accept the license agreement 
and install PhotoStarter. 

Do the same thing when you see the EPSON Card Monitor Setup.

3. When setup is complete, select Yes to 
restart your computer and click Finish. 
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Leave in the CD-ROM as your computer 
restarts. You see the Optional Software menu:

Note: If you don’t see this screen, click the 
EPSON CD-ROM icon and click the EPSON 
icon.

4. Click the button for each program you want 
to install and follow the instructions on the 
screen.

5. If you see a message about installing 
QuickTime, click Yes and follow the on-screen instructions. You don’t need a 
registration number.

6. When you’re finished installing software, close any open windows and click Exit.

7. When you see the registration screen, register your printer with EPSON as 
instructed. Remove the CD-ROM and keep it in case you need to reinstall any 
software later. You’re ready to print. 
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Solving Problems

See “Diagnosing Printer Problems” on page 85 to help determine the cause of your 
printer problem. Then see these sections for solutions:

■ “Setup and Software Installation Problems” on page 88

■ “Printer Problems” on page 89

■ “Quality Problems” on page 91

■ “Paper Problems” on page 93

■ “Miscellaneous Problems” on page 95

■ “Uninstalling and Reinstalling the Printer Software (Windows)” on page 97

■ “Where To Get Help” on page 98

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.
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Printer Parts

Power button

Maintenance button

Roll paper button

Processing light

Ink cartridge replacement button

Error light

Paper support

Preview monitor slot

Printer cover

Card eject button

Memory card slot

Output tray extensions
Output tray

Left edge guide

Roll paper 
adapter

Roll paper holders

Paper thickness lever

Preview monitor port

USB port

Ink cartridges

���������	�
��������� ���������������������������



Solving Problems 85

Diagnosing Printer Problems

First, check the printer’s lights and messages as described below:

Lights Message Explanation

Green 
Processing light 
flashes 

The printer is receiving a print job, reading a memory card, 
printing, or performing maintenance procedures.

Red b light is 
on

Your paper ran out, ink ran out, or paper is jammed. You 
may also see one of the messages shown below, or a 
message on your screen.

■ If paper is out, load more paper, then press the b 
maintenance button to resume printing. 

■ If paper is jammed, press the b maintenance button 
to eject the paper. (If you’re printing on roll paper, 
press and hold down the z roll paper button for at 
least three seconds to clear the jam.)

If that doesn’t work, turn off the printer, open the 
cover, and remove all the paper, including any torn 
pieces. Then reload paper, turn on the printer, and 
press the b maintenance button.

■ If you see IEb (Ink Empty black) or IEc (Ink Empty 
color) on the control panel, you need to replace one of 
your ink cartridges. Replace the cartridge as described 
on page 63.

■ If you see IC (Ink Cartridge) on the control panel, one 
of the cartridges is not installed correctly. Remove it 
and install it correctly, as described on page 65.

Red b light 
flashes

One of the ink cartridges is low. Make sure you have a 
replacement cartridge. Check the message that appears on 
your screen or on the control panel to see if you need a 
black (ILb) or color (ILc) cartridge.

Cut your picture(s) off the roll. Then press the z roll paper 
button to feed the paper back into the printer.

Green 
Processing light 
flashes and red 
b light is on

Press the b maintenance button, then remove any paper 
in the printer. Turn off the printer, open the cover, and 
remove any paper or other foreign objects. Make sure 
there is sufficient space around the vents on the back of 
the printer. Then turn the printer on again. If the lights are 
still on, contact your dealer or EPSON. (See page 98.)
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source. The printer check also shows how much black and color 
ink you have left.

1. Make sure both the printer and computer are turned off. Then disconnect the 
USB cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Hold down the b maintenance button, then press and release the Ppower 
button. Continue holding down the b maintenance button until the 
Processing light starts to flash, then release it.

Green 
Processing light 
and red b light 
flash 

An unknown printer error has occurred. Turn off the printer 
and contact your dealer or EPSON; see page 98 for contact 
information.

Red b light 
flashes

Internal printer parts need adjustment or replacement. 
Turn off the printer, wait a few seconds, then turn it back 
on. If you still see the error, contact EPSON as described 
on page 98. 

Red b light 
flashes

The memory card is not compatible with the printer, or it is 
damaged or the data is corrupted. Make sure the card is 
compatible (see page 8) and then try reformatting it in your 
camera.
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The printer prints one page showing its ROM version number, black and color 
ink percentages remaining, and a nozzle check pattern. (If the pattern has gaps in 
its dots, you need to clean the print head; see page 61.)

4. Turn off the printer after it prints the check page. Then reconnect the cable and 
turn on your printer and computer.

■ If the check page prints, the problem probably lies in your memory card, 
software settings, the interface cable, or your computer. Your software may 
not be installed correctly.

■ If the check page doesn’t print, you may have a problem with your printer. 
Try the suggestions in “Problems and Solutions” beginning on page 88. If 
nothing works, contact your dealer or EPSON as described on page 98.

���������	�
�������������������������������������



88 Solving Problems

Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink 
cartridge installation.

■ When you install ink cartridges, 
the printer must charge its print 
head for a few minutes. Wait 
until it’s finished (the green 
Processing light stops flashing) 
before you turn off the printer, 
or it may use excess ink the next 
time you turn it on. 

■ If the printer stops moving or 
making noise, but the green 
Processing light is still flashing 
after 5 minutes, turn off the 
printer. If the light is still 
flashing when you turn it back 
on, contact EPSON as 
described on page 98.

■ Make sure the ink cartridge 
clamps are locked down 
completely and no packing 
material remains in the printer. 
Turn off the printer, wait a 
moment, then turn it back on to 
clear the error.

You’re having problems installing 
the printer software.

■ Turn on your printer and make 
sure its cable is securely 
connected at both ends. Follow 
the installation steps on the 
Start Here sheet, and make sure 
your system meets the 
requirements on page 101.

■ Close other programs, including 
screen savers and virus 
protectors, and install again.

■ If the SP825 icon doesn’t 
appear in the Macintosh 
Chooser, you may have an 
extension conflict. Turn off any 
unnecessary extensions and 
restart your Mac.

■ If you see an error message in 
Windows 2000 or Windows 
XP, you may not have software 
installation privileges. Contact 
your System Administrator.

■ If you’re using Windows 98, 
Me, 2000, or XP, make sure 
your system was not upgraded 
from Windows 95; the USB 
driver may not install correctly.
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■ Make sure the USB Controller 
is working properly in Device 
Manager. See your Windows 
help system for details.

■ If you’re printing over a 
network, see your on-screen 
Reference Guide for instructions 
on configuring your printer.

Printer Problems

Only the green Processing light is 
on, but nothing prints.

■ Make sure the USB cable is 
securely connected at both ends 
and meets the system 
requirements on page 101.

■ Run a printer check as described 
on page 86. If the test page 
prints, make sure your software 
is installed correctly. 

■ If you’re printing on a network, 
you need to set up your printer 
for network printing, as 
described in your on-screen 
Reference Guide.

■ In Windows, make sure your 
printer is selected as the default 
printer in the Printers utility.

The printer sounds as though it is 
printing, but nothing prints.

■ The print head nozzles may 
need cleaning; see page 61 for 
instructions.

■ The printer won’t operate 
properly if it’s tilted or at an 
angle. Place it on a flat, stable 
surface.

Your printer makes noise when 
you turn it on or after it has been 
sitting for awhile.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements listed on page 101. If 
you’re printing a high-resolution 
image, you need more than the 
minimum requirements. You may 
also need to:

■ Clear space on your hard drive 
or run a defragmentation utility.

■ Close open programs that 
you’re not using.

■ Increase your system’s memory 
(RAM).

■ In Windows 98 or Me, 
right-click the  EPSON 
CardMonitor icon and select 
Turn off monitoring.
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For the fastest printing, try these 
tips:

■ Select Draft as the Quality Type 
(Windows) or set the 
Quality/Speed slider to Speed 
(Macintosh).

■ In the Advanced window, turn 
MicroWeave® off (Macintosh 
only) and turn High Speed on.

Your memory card does not work 
correctly.

■ Make sure the card’s capacity is 
512MB or less and it only 
contains photos taken with a 
DCF-compliant digital camera.

■ Make sure you follow the 
instructions on the Start Here 
sheet to install PhotoStarter and 
CardMonitor. (You won’t have 
these utilities if you’re using 
Windows XP.) 

■ Check your PhotoStarter 
settings. See page 10 for 
instructions.

■ If you access the card from your 
computer and delete files, the 
card may not work correctly 
with your camera. Always delete 
pictures using your camera.

The optional preview monitor 
and control panel respond too 
slowly.

When you have lots of photos or 
large files on your memory card, it 
takes longer for the preview monitor 
to process them. This causes the 
monitor and control panel to 
respond more slowly. Try deleting 
any photos you don’t need before 
you remove the card from your 
camera.
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Quality Problems

You see banding (light lines).

■ Clean the print head; see 
page 61 for instructions. 

■ Select a higher print quality and 
turn off High Speed mode; see 
page 45 (Windows) or page 48 
(Macintosh) for details.

■ Select the correct Type 
(Windows) or Media Type 
(Macintosh) for your paper; see 
page 49.

■ Make sure the printable side of 
the paper is face up. It’s usually 
whiter or shinier.

■ Choose Best Photo in the 
Quality Type setting 
(Windows).

■ Make sure Maximum is not 
selected as the printable area 
setting in your printer software; 
this may cause banding in the 
expanded area.

■ The ink cartridges may need 
replacing. To replace them, see 
page 63.

■ Try using Automatic mode 
(Macintosh only); see page 41 
(OS 8.6 to 9.x) or page 43 
(OS X).

■ Align the print head as 
described on page 68.

■ Select MicroWeave if the setting 
is available.

■ Set the paper thickness lever to 
the 0 position. Set the lever to 
the + position when you print 
on thicker paper or envelopes. 
You may also need to turn off 
High Speed (in the Advanced 
window). 
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Your print is blurry or smeared.

■ Make sure your paper isn’t 
damp or curled, or loaded face 
down (the printable side should 
be face up). Reload new paper 
face up.

■ Make sure the printer is on a 
flat, stable surface.

■ Check the paper thickness lever 
setting. The lever should be set 
to the 0 position for most 
papers. Set it to the + position 
when you print on thicker paper 
or envelopes. 

■ Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the 
on-screen Reference Guide. 

■ Use EPSON papers for proper 
saturation and absorption of 
genuine EPSON inks. 

■ Align the print head as 
described on page 68.

Your printout is faint or has gaps.

■ Clean the print head; see 
page 61 for instructions. 

■ The ink cartridges may be old or 
low on ink; see page 63. 

■ Select the correct Type 
(Windows) or Media Type 
(Macintosh) for your paper; see 
page 49.

■ Make sure your paper isn’t 
damaged, old, dirty, or loaded 
face down. If it is, load new 
paper face up. For best results, 
use genuine EPSON paper.

Your printout is grainy.

■ Use a higher quality paper or 
select a higher Quality Type 
(Windows; page 39) or Print 
Quality (Macintosh; page 41). 

■ Align the print head; see 
page 68 for instructions.

■ Increase the image resolution or 
print it in a smaller size; see your 
software documentation.
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You see wrong or missing colors.

■ Make sure Black Ink Only is off 
(Windows) or Color ink is 
selected (Macintosh), even 
when printing black and white 
photographs.

■ Clean the print head; see 
page 61 for instructions.

■ The ink cartridges may be old or 
low on ink; see page 63.

■ Try turning off PhotoEnhance. 
Also check if you’re using a 
special effect that alters image 
colors, like Sepia.

■ Try using Automatic mode 
(Macintosh only); see page 41 
(OS 8.6 to 9.x) or page 43 
(OS X).

■ Try changing the Gamma 
setting; see page 45 (Windows) 
or page 48 (Macintosh).

■ Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system—
such as ICM (Windows; see 
page 45) or ColorSync 
(Macintosh; see page 48)—to 
get as close as possible. 

Paper Problems

Paper doesn’t feed correctly or 
jams in the printer.

■ If paper doesn’t feed, remove it 
from the sheet feeder. Fan the 
edges of the sheets, reload them 
against the right edge, then slide 
the left edge guide snugly, but 
not too tightly, against the 
paper.

■ If paper jams, press the 
b maintenance button to clear 
the jam. If necessary, open the 
cover and remove any jammed 
or torn pieces. Load new paper 
and press the b maintenance 
button.

■ If multiple pages feed at once, 
remove the paper from the sheet 
feeder, fan the edges to separate 
the sheets, and carefully reload 
it.

■ Use new, smooth, high-quality 
paper, loaded printable side up.

■ Don’t load paper above the 
arrow mark on the left edge 
guide.

■ Make sure the edges of the 
paper are not curled. If they are, 
lay the paper flat (inside the 
package), face down, and place a 
heavy, flat book on top of it 
(overnight, if possible).
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Paper doesn’t eject fully or is 
wrinkled.

■ If the paper doesn’t eject 
fully, you may have set the 
wrong paper size. Press the 
b maintenance button to eject 
the paper, then select the correct 
paper size.

■ If it’s wrinkled when it ejects, 
the paper may be damp or too 
thin. Load new paper.

Roll paper doesn’t feed correctly.

■ To load roll paper correctly, 
gently hold the paper in place 
with your hand while you press 
the z button. Don’t force the 
paper to feed into the printer. 
Allow the paper to feed 
automatically.

■ If paper is curled, roll the paper 
inside a folded sheet of paper in 
the direction opposite to the 
paper’s curl. You don’t need to 
uncurl the entire roll—only 
about 9 inches. See page 25 for 
instructions.

■ Use a triangle or other tool to 
make sure the end of the roll is 
cut perpendicular to the edges. 
If the end is cut on a diagonal, 
the paper may not feed 
smoothly. 

■ If you see a paper jam error 
message, press the z roll paper 
button for four seconds to clear 
the error.

■ If the red b error light is on, 
press the b maintenance 
button and wait for the light to 
go off. Then press the z roll 
paper button to resume 
printing.

■ Remove the paper support and 
close the output tray extensions.

■ Always select Roll Paper 
as the Paper Source setting. 
If Sheet Feeder (or Auto Sheet 
Feeder) is selected, paper will 
feed unnecessarily after each 
print job. In addition, a great 
deal of paper may feed 
unnecessarily when you turn 
your computer off and then on 
again.

■ If extra paper feeds after a print 
job or after you turn on the 
printer, press the z roll paper 
button for three seconds to 
rewind the paper. (You may 
need to repeat this step to 
rewind the paper completely.) 
Then press the b maintenance 
button to turn off the b error 
light. Finally, reload the paper 
and press the z roll paper 
button again to resume 
printing.

���������	�
��������" ���������������������������



Solving Problems 95

■ Always press the z roll paper 
button to feed roll paper. If you 
press the b maintenance 
button instead and then turn 
either the printer or your 
computer off and on again, 
paper will feed unnecessarily 
and you’ll see a paper jam error 
message.

Miscellaneous 
Problems

The image is inverted, as if viewed 
in a mirror.

Turn off Mirror Image (Windows) 
or Flip Horizontal (Macintosh) in 
the printer software, or the mirror 
setting in your program. (If you’re 
printing on EPSON Iron-On 
Transfer Paper, the image should be 
inverted.)

The printer prints blank pages.

■ Make sure your printer is 
selected in the Print window, or 
the Macintosh Chooser or Print 
Center.

■ Clean the print head; see 
page 61 for instructions. 

You see incorrect characters.

■ Make sure the USB cable is 
securely connected at both ends 
and meets the system 
requirements on page 101. 

■ Make sure your printer is 
selected in the Print window, or 
the Macintosh Chooser. 

■ If you’re using a switch box or 
USB hub with your printer, 
connect the printer directly to 
your computer instead.

The margins are incorrect.

■ Make sure the paper settings are 
correct for your paper size. See 
page 39 (Windows), page 40 
(Macintosh OS 8.6 to 9.x), or 
page 42 (Macintosh OS X).

■ Choose the correct margins for 
your paper size. The margins 
must be within the printable 
area of the page; see “Printer 
Specifications” in your 
on-screen Reference Guide.

■ Make sure your paper is 
positioned next to the right side 
of the feeder and the left edge 
guide is snug against the other 
side. Don’t load paper above the 
arrow on the left edge guide.
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96 Solving Problems

Image size or position is 
incorrect.

■ Make sure paper and layout 
options are set correctly.

■ Your images may not match the 
width/height proportions 
(aspect ratio) of the paper size or 
layout you’re using. Images may 
be cropped or trimmed around 
the edges to fit the paper and 
layout.

The wrong photo is printed.

The photo numbering in the printer 
may not match the numbering in 
your camera. If you’re printing 
without a computer, first print an 
index to identify your photos.

Too many copies are printing.

Make sure that the Copies option in 
your printer software or program is 
not set for multiple copies.
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Uninstalling and Reinstalling the Printer 
Software (Windows)

You may need to uninstall and then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
your other photo software or your on-screen Reference Guide. 

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select 
EPSON Printer Software Uninstall.

3. In the next window, make sure EPSON Stylus Photo 
825 is selected and click OK. Then follow the 
on-screen instructions. 

4. Restart your computer, then see the Start Here sheet to reinstall your software. 
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98 Solving Problems

Where To Get Help

If you need help with your printer, Film Factory, or the P.I.M. Plug-in for Adobe 
Photoshop, see the contact information below. See the information on page 99 if you 
need help with the other photo software that came on your printer CD-ROM.

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table.

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Standard Time, Monday through 
Friday and 7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Standard Time, Monday through 
Friday.

Toll or long distance charges may apply. 

Before you call, please have the following information ready:

■ Product name (EPSON Stylus Photo 825)

■ Product serial number (located on the back of the printer and on its box)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, seven 
days a week. To use these services, you must have a touch tone 
telephone and call (800) 922-8911. Your EPSON SoundAdvice  
Express Code is 70405. Use this code to quickly select the EPSON 
Stylus Photo 825 in SoundAdvice. 

SM
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You can purchase ink cartridges, paper, manuals, and accessories from the EPSON 
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral.

If you need help with ArcSoft PhotoImpression, use this information: 

■ Web site: www.arcsoft.com/techmain.htm

■ E-mail: support@arcsoft.com

■ Telephone: (510) 440-9901, 8:30 AM–5:30 PM PST, Monday through Friday
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Requirements and Notices

Windows System Requirements

To use your printer and its software, your system should have: 

■ A Microsoft Windows compatible PC with a Pentium® or better processor, 150 MHz (233 MHz 
required for Windows XP, 300 Mhz or faster recommended) 

■ Microsoft Windows 98, Windows Me, Windows 2000, or Windows XP

■ 64MB of RAM (128MB or more recommended) 

■ 100MB of free hard disk space (200MB or more recommended)

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable no longer than 6.5 feet (2 meters).

Macintosh System Requirements

To use your printer and its software, your system should have: 

■ An Apple® iMac™ series, Power Macintosh® G3 or G4, PowerBook,® or iBook™ with built-in 
USB port

■ Mac® OS 8.6 through OS X 10.1 or higher (Mac OS 9.04 or later recommended)

■ At least 64MB of available RAM (more recommended)

■ At least 100MB of free hard disk space (200MB recommended)

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable no longer than 6.5 feet (2 meters).
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Caution: Always turn the printer off using the Ppower button. It may take a moment for 
the printer to shut off after you press the button. Don’t switch off the power strip or 
unplug the printer until the green Processing light is off.

■ Use a soft, dry cloth only to clean the display and optional preview monitor. Do not use liquid or 
chemical cleaners on these parts. 

■ Always leave the cover on the preview monitor slot, unless you are using the optional preview 
monitor.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Do not remove a memory card or turn off the printer while the computer and card are 
communicating (when the Processing light is flashing). Doing so can corrupt files on the 
memory card.
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■ If the liquid crystal solution from the display or the optional preview monitor gets on your hands, 
wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush 
them immediately with water. If discomfort or vision problems remain after a thorough flushing, 
see a physician immediately. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Do not shake an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy efficiency. 
The EPA ENERGY STAR office equipment program is a voluntary 
partnership with the computer and office equipment industry to 
promote the introduction of energy-efficient personal computers, 
monitors, printers, fax machines, and copiers in an effort to reduce 
air pollution caused by power generation.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: P270A
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Epson America, Inc. Limited Warranty

What Is Covered:  Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the 
EPSON printer covered by this limited warranty statement, if purchased and used in the United States 
or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems:  Should your EPSON printer prove defective during the 
warranty period, please call the EPSON Connection  at (562) 276-7282 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions).  Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement.  Epson requires a debit or credit card number to secure the cost of the replacement printer 
in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct 
you to send your printer to Epson or its authorized service center where the printer will be fixed and 
sent back to you. You are responsible for packing the printer and for all costs to and from the Epson 
authorized service center. When warranty service involves the exchange of the printer or a part, the 
item replaced becomes Epson property. The replacement printer or part may be new or refurbished to 
the Epson standard of quality, and at Epson’s option, may be another model of like kind and quality. 
Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of 
the covered printer. Exchange products and parts assume the remaining warranty period of your 
original product covered by this limited warranty. 

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada.  This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting.  This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover 
ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.

SM
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE.  SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES.  IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE.  UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID.  EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you.  This warranty gives you specific legal rights 
and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ■  P. O. Box 93012 ■  Long Beach, CA 90809-3012
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Index

Numerics

360 dpi Ink Jet Paper setting, 49
4 x 6-inch Photo Paper, 20

A

Accessories, 99
Adobe Photoshop, P.I.M. plug-in for, 3, 56 to 59
Advanced settings, 45 to 48
Aligning print head, 68
ArcSoft PhotoImpression, 4, 51, 99
Automatic mode, Macintosh, 41, 43, 91

B

Background printing, 41
Banding, 91
Basic printing

Macintosh, 40 to 44
Windows, 38 to 40

Black Ink Only setting, 45, 93
Blank pages, 95
Blurry images, 92
BorderFree printing, 16, 50 to 51, 54
Borderless Photo Paper, 20
Borderless setting, 51
Bright White Paper, 49
Brightness, adjusting, 30
Browser, 5
Buttons, 14, 84

C

Cable, printer, 101
Cancelling printing

Macintosh, 41, 44
Windows, 39
without computer, 14

CardMonitor, 10, 11
Characters, incorrect, 95
Checking printer, 86 to 87
Chooser, Macintosh, 88, 95
Cleaning

print head, 61 to 63
printer, 69
sheets, 69

Color Management settings
Mac OS 8.6 to 9.x, 47 to 48
Mac OS X, 43
Windows, 45

Color problems, 93
ColorLife Photo Paper, 12 to 14, 21 to 22, 49
ColorSync, 43, 47 to 48, 93
CompactFlash memory card, 8
Control panel, 14 to 17, 84 to 86, 90
Controlling printing

Macintosh, 41, 44
Windows, 39

Copies setting, 96
without computer, 17

Custom settings
Macintosh, 47 to 48
Windows, 45 to 46
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D

Declaration of Conformity, 105
Default settings

control panel, 18
Windows, 40

Digital camera files, 8
Documentation, 4 to 6
Double-Sided Matte Paper, 49
DPOF (Digital Print Order Format), 19

E

Electronic manual, 4 to 6
Energy Star compliance, 104
Enlargements, printing without computer, 21 

to 22
EPSON

Connection, 106
help, 98 to 99
papers, 12 to 14, 49
PhotoCenter, 4
SoundAdvice, 98
Store, 13, 64
warranty, 106 to 107

Exif Print
description, 2 to 3
with Film Factory, 51 to 55

F

Faint images, 92
FCC Compliance Statement, 104
Files, printing without computer, 8
Film Factory, 3, 51 to 55
Film, Photo Quality Glossy, 49
Filters

without computer, 31
Flip Horizontal setting, 95
Frames, adding to stickers, 33 to 34

G

Gamma setting, 45, 48, 93
Glossy media, 12 to 14, 21 to 22, 49
Grainy prints, 92
Greeting Cards, Glossy Photo, 49

H

Head Cleaning utility, 61 to 62
Heavyweight matte paper, 12 to 14, 21 to 22
Help

EPSON, 98 to 99
High Speed setting, 90 to 91
High-quality (resolution) images

without computer, 17

I

ICM (Image Color Matching) setting, 45, 93
ID sheets, 34
Incorrect

characters, 95
colors, 93
margins, 95

Index, printing without computer, 19
Ink cartridge

level of ink in, 39, 41, 63 to 64, 87
ordering, 64
problems, solving, 88
replacing, 63 to 67
safety instructions, 65 to 66, 103

Ink Jet Transparencies, 49
Ink level, checking

Macintosh, 41, 64
Windows, 39, 64
without computer, 87

Installation problems, 88 to 89
Inverted image, 95
Iron-On Transfer Paper, 49, 95
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J

Jams, paper, 93 to 95
JPEG files, printing requirements, 8

L

Layout problems, 96
Layout settings

Macintosh, 41, 43
Windows, 45 to 46
without computer, 16

Letterhead, 36
Lever, thickness, 37, 91
Lights, 84 to 86

M

Macintosh
basic printing, 40 to 44
Chooser, 88, 95
installing software, 71 to 75
system requirements, 101

Maintaining printer, 61 to 69
Marginless printing, 16
Margins, incorrect, 95
Matte Paper Heavyweight, 12 to 14, 21 to 22, 

49
Matte Paper, Double-Sided, 49
Media Type setting

Mac OS 8.6 to 9.x, 41, 47 to 48, 91
Mac OS X, 43, 47 to 48, 91
selecting correct, 49
Windows, 39, 45, 91

Memory cards, inserting, 8 to 9
Memory Stick, 8
Microdrive, 8
MicroWeave setting, 90
Mirror Image setting, 95
Monitoring ink level

Macintosh, 41, 64
Windows, 39, 64
without computer, 87

Moving printer, 70

N

Network printing, 89
Noise, printer, 89
Nozzle Check, 62 to 63
Numbering of photos, 20

O

Orientation setting, 39 to 40, 42, 51

P

P.I.M., see PRINT Image Matching
Page Layout setting, 16
Page Setup, Macintosh, 40, 42
Panoramic

paper, 49
photos, 34

Paper
EPSON, 12 to 14, 49
feeding problems, 93 to 94
jams, 93 to 95
loading, 13 to 14, 36 to 37
orientation, 39 to 40, 42, 51
size, 16
thickness lever, 37, 91

Paper Size setting, 16, 39 to 40, 42, 50
Paper Type setting, 15
PC card, 8
PCMCIA adapter, 8
Photo Paper, 12 to 14, 20, 49
Photo Quality Glossy Film, 49
Photo Quality Glossy Paper, 49
Photo Quality Ink Jet Cards, 49
Photo Quality Ink Jet Paper, 12, 49
Photo RPM setting, 45, 48
Photo Stickers, 12, 32 to 34, 49
PhotoCenter, EPSON, 4
PhotoEnhance, 17, 30, 93
Photographs, displaying and storing, 12
PhotoImpression, ArcSoft, 4, 51, 99
PhotoStarter, 10 to 11
Premium Bright White Paper, 49
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Premium Glossy Photo Paper, 12 to 14, 21 to 
22, 49

Premium Semigloss Photo Paper, 12, 49
Preprinted paper, 36
Preview monitor, 1, 84, 90
Previewing printout, 39, 41 to 43
Print dialog box, 38
Print head

aligning, 68
cleaning, 61 to 63

Print Head Alignment utility, 68
PRINT Image Matching

description, 2 to 3, 7
plug-in for Photoshop, 3, 56 to 59
printing without a computer, 17
with ArcSoft PhotoImpression, 4, 51
with Film Factory, 51 to 55

Print Mode setting, 15
Print quality problems, 91 to 93
Printer

cable, 101
check, 86 to 87
cleaning, 69
control panel, 14 to 17, 84 to 86, 90
maintaining, 61 to 69
noise, 89
parts, 84
problems, 85 to 87, 89 to 90
transporting, 70

Printing
advanced, 45 to 48
BorderFree, 50 to 51, 54
controlling, 39, 41, 44
Macintosh, basic, 40 to 44
Windows, basic, 38 to 40
with custom settings, Macintosh, 47 to 48
with custom settings, Windows, 45 to 46
with PhotoEnhance, 17, 30, 93
with PRINT Image Matching, see PRINT 

Image Matching
without computer, 7 to 34

Problems
diagnosing, 85 to 86
installing software, 88 to 89
memory card, 90
miscellaneous, 95 to 96
paper feeding, 93 to 94
PhotoStarter, 90
preview monitor, 90
print quality, 91 to 93
printer, 85 to 87, 89 to 90
solving, 83 to 99

Progress Meter, 39

Q

Quality setting, 17
Quality Type setting, 39, 50, 90

R

Reference Guide, 4 to 6
Reinstalling software, 97
Resolution Performance Management (RPM), 

1, 45, 48
Roll paper

feeding problems, 94
loading, 25 to 27
printing, 27 to 29

RPM, 1, 45, 48

S

Safety instructions, 102 to 103
Select Photo setting, 17
Self adhesive sheets, 49
Semigloss Photo Paper, 12 to 14, 49
Service, 98 to 99
Size setting, 39
Slow printing, 89
SmartMedia card, 8
Smeared printout, 92
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Snapshots
printing on roll paper, 25 to 29
printing without computer, 19 to 21

Software
installation problems, 88 to 89
installing, 71 to 81
reinstalling, 97
summary, 3 to 4
uninstalling, 97

SoundAdvice, 98
Stickers, 12, 32 to 34, 49
Support, 98 to 99
System requirements, 101

T

Technical support, 98 to 99
Thickness lever, 37, 91
Transfer paper, 49, 95
Transparencies, 49
Transporting printer, 70
Troubleshooting, 83 to 99
Type setting, 39, 91

U

Uninstalling software, 97
USB, 88, 95, 101
Utilities

Head Cleaning, 61 to 62
Nozzle Check, 62 to 63
Print Head Alignment, 68

W

Warranty, 106 to 107
Windows

basic printing, 38 to 40
default settings, 40
installing software, 76 to 81
system requirements, 101
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